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This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions: 

(1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that may cause 
undesired operation.

Copyright Notice
Hemisphere GPS Precision GPS Applications

Copyright © Hemisphere GPS (2008). All rights reserved.

No part of this manual may be reproduced, transmitted, transcribed, stored in a retrieval system 
or translated into any language or computer language, in any form or by any means, electronic, 
mechanical, magnetic, optical, chemical, manual or otherwise, without the prior written 
permission of Hemisphere GPS.

Trademarks
HEMISPHERE GPS®, the Hemisphere GPS logo, CRESCENT®, ECLIPSETM, COASTTM, e-DIF®, 
OUTBACKTM, OUTBACK Guidance®, OUTBACK Guidance CenterTM, OUTBACK STM, OUTBACK 
S-LiteTM, OUTBACK S2TM, OUTBACK 360TM. OUTBACK Steering GuideTM, OUTBACK HitchTM, 
SATLOC®, the Satloc logo, eDrive®, eDriveTCTM, Just Let GoTM, e-DifTM and BaseLineHDTM are 
proprietary trademarks of Hemisphere GPS. Other trademarks are the properties of their 
respective owners.

Patents
The OUTBACK STM and S-LiteTM automated navigation and steering guide system is covered by 
U.S. Patents No. 6,539,303 and No. 6,711,501. The OUTBACK HitchTM automated hitch control 
system is covered by U.S. Patent No. 6,631,916. The OUTBACK eDriveTC GPS assisted steering 
system is covered by U.S. Patent No. 7,142,956. Hemisphere GPS products may be covered by 
one or more of the following U.S. Patents: 

Other U.S. and foreign patents pending.

6,111,549 6,397,147 6,469,663 6,501,346 6,539,303

6,549,091 6,631,916 6,711,501 6,744,404 6,865,465

6,876,920 7,142,956 7,162,348 7,277,792 7,292,185

7,292,186 7,373,231 7,400,956 7,400,294 7,388,539

7,388,539 7,429,952
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Notice to Customers
Contact your local dealer for technical assistance. To find the authorized dealer near you, call or 
write us at:

Hemisphere GPS 
4110 9th Street S.E. 
Calgary, Alberta, Canada T2G 3C4

Telephone number: 
Fax number: 
E-mail address:

(403) 259-3311 
(403) 259-8866 
sales@hemispheregps.com



Warranty Notice

Covered Products
This warranty covers all products manufactured by Hemisphere GPS (the "Products").

Hemisphere GPS Limited Warranty
Hemisphere GPS hereby warrants solely to the end purchaser of the Products, subject to the exclusions and 
procedures set forth herein below, that the Products sold to such end purchaser shall be free, under normal use and 
maintenance, from defects in material and workmanship for a period of 12 months from delivery to such end 
purchaser. Repairs and replacement components are warranted, subject to the exclusions and procedures set forth 
below, to be free, under normal use and maintenance, from defects in material and workmanship for 90 days from 
performance or delivery, or for the balance of the original warranty period, whichever is greater. 

Purchaser's Exclusive Remedy
The end purchaser's exclusive remedy under this warranty shall be limited to the repair or replacement, at the option 
of Hemisphere GPS, of any defective Products or components thereof. The end user shall notify Hemisphere GPS or 
a Hemisphere GPS approved service center immediately of any claimed defect. Repairs shall be made through a 
Hemisphere GPS approved service center only. 

Exclusions
Hemisphere GPS does not warrant damage occurring in transit or due to misuse, abuse, improper installation, 
neglect, lightning (or other electrical discharge) or fresh/salt water immersion of Products. Repair, modification or 
service of Hemisphere GPS products by any party other than a Hemisphere GPS approved service center shall render 
this warranty null and void. Hemisphere GPS does not warrant claims asserted after the end of the warranty period. 
Hemisphere GPS does not warrant or guarantee the precision or accuracy of positions obtained when using 
Products. Products are not intended for primary navigation or for use in safety of life applications. The potential 
accuracy of Products as stated in Hemisphere GPS literature and/or Product specifications serves to provide only an 
estimate of achievable accuracy based on:

• Specifications provided by the US Department of Defense for GPS Positioning,
• DGPS service provider performance specifications.

Hemisphere GPS reserves the right to modify Products without any obligation to notify, supply or install any 
improvements or alterations to existing Products.

No Other Warranties
THE FOREGOING WARRANTY IS EXCLUSIVE OF ALL OTHER WARRANTIES, WHETHER WRITTEN, ORAL, IMPLIED OR ARISING BY STATUTE, 
COURSE OF DEALING OR TRADE USAGE, IN CONNECTION WITH THE DESIGN, SALE, INSTALLATION, SERVICE OR USE OF ANY PRODUCTS 
OR ANY COMPONENTS THEREOF, INCLUDING, BUT NOT LIMITED TO, ANY WARRANTY OF MERCHANT ABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

Limitation of Liability
THE EXTENT OF HEMISPHERE GPS’ LIABILITY FOR DAMAGES OF ANY NATURE TO THE END PURCHASER OR ANY OTHER PERSON OR 
ENTITY WHETHER IN CONTRACT OR TORT AND WHETHER TO PERSONS OR PROPERTY SHALL IN NO CASE EXCEED, THE AGGREGATE, THE 
COST OF CORRECTING THE DEFECTIVE ITEM. IN NO EVENT WILL HEMISPHERE GPS BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF USE 
OR FOR ANY SPECIAL, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR CONTINGENT DAMAGES, EVEN IF HEMISPHERE GPS HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. WITHOUT LIMITING THE FOREGOING, HEMISPHERE GPS SHALL NOT BE LIABLE FOR 
ANY DAMAGES OF ANY KIND RESULTING FROM INSTALLATION, USE, QUALITY, PERFORMANCE OR ACCURACY OF ANY PRODUCTS.

Governing Legislation
To the greatest extent possible, this warranty shall be governed by the laws of the State of Arizona. In the event that 
any provision hereof is held to be invalid by a court of competent jurisdiction, such provision shall be severed from 
this warranty and the remaining provisions shall remain in full force and effect. 



Obtaining Warranty Service
In order to obtain warranty service, the end purchaser must bring the Product to a Hemisphere GPS approved service 
center along with the end purchaser's proof of purchase. For any questions regarding warranty service or to obtain 
information regarding the location of any of Hemisphere GPS' approved service centers, contact Hemisphere GPS at 
the following address:

Hemisphere GPS 
8444 N. 90th Street, Suite 130 
Scottsdale, AZ 85258 
Phone: 480-348-9919 Fax: 480-348-6370 
techsupport@hemispheregps.com 
www.hemispheregps.com

Documentation Feedback
Hemisphere GPS is committed to the quality and continuous improvement of our products and services. We urge you 
to provide Hemisphere GPS with any feedback regarding this guide by writing to the following e-mail address: 
DocFeedback@hemispheregps.com
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Overview

The R220 GPS Receiver is the latest addition to Hemisphere GPS’ 
precision product line. It is ideal for a number of applications including 
navigation and guidance, land and marine surveying, and machine 
control and monitoring. It boasts the latest dual frequency technology in 
the Eclipse board and features fast, reliable, long range RTK (Real Time 
Kenematic) performance. 

The R220 tracks GPS, SBAS and L-Band (OmniSTAR VBS®). It also 
utilizes Hemisphere GPS’ exclusive COAST™ technology, which 
provides positioning data during differential signal outages. 
2
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 What’s Included

Please look over the parts shipped with your system. If any part appears 
to have been damaged during shipping, please contact your freight 
carrier. If any parts are missing, please contact your dealer.

Figure 1-1. R220 system parts diagram.

A.

B.

C.D.

F.

G.

H.

I.
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Parts List

Table 1-1:  R220 Series Parts List

Diagram 
Letter

Part Name Qty Part Number

A CBL, IO-x, DSUB(F)9-DSUB(M)9, 
3M

1 050-0011-022

B CLB, RF-X, TNC(M)-TNC(M), 5M 1 052-0005-000

C CBL, PWR-X, CIRC(F) 2-PT, 3M 1 054-0009-000

D KIT, MOUNTING, R100 1 710-0056-000

E MNL, USER.GUIDE, ECLIPSE.R220 1 875-0212-000

F ASSY, A-SERIES.ANTENNA, MNT, 
AG

1 720-0033-00A

G CBL, IO-X, USB A-USB A, 3M 1 051-0192-000#

H L1/L2, GPS L-BAND, ANTENNA 1 804-3035-000

I ECLIPSE GPS RECVR, R220,USB 1 802-1048-000#
4
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Introduction

The R220 is easily set up for operation. This chapter provides 
information on the following topics:

• Mounting the receiver

• Mounting the antenna

• Cable interface

• Connecting the cable to other devices
6
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Mounting the Receiver

R220 Placement

While it is not necessary to mount the R220, should you decide to do so, 
you have several options. When choosing a mounting location, please 
ensure the menu screen, LEDs and buttons are visible and accessible. 
Please also ensure access to the back panel is available for switching 
out cables and accessing the power button. There is an option within 
the menu system to switch the direction of the display. If it is easier to 
mount the unit upside down, it can be mounted this way and still 
operate the display easily. 

Note: When mounting the R220, mount the unit inside and 
away from the elements and in a location that minimizes 
vibration, shock, extreme temperatures and moisture.
7
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Several thumb screws, nuts and brackets are provided to mount the 
R220.

To install the brackets for mounting:

1. Slide the nuts through the openings along the sides of the receiver.

2. Place the bracket alongside the receiver and insert the 
thumbscrews so they screw into the nuts.

3. Screw down the brackets.
8
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Mounting the Antenna

Placement of the antenna is crucial to the system’s operation. The GPS 
receiver inside the R220 computes a position based upon 
measurements from each satellite to the phase center of the antenna. 
Mount the antenna in the location where the reference position should 
be. When choosing a location to mount the antenna, make sure it has a 
clear view of the sky. This will ensure that the GPS satellite signals are 
not obstructed, which can reduce the system’s performance. 

When mounting the antenna try to:

Mount the antenna on, or as close to, the center of the point of 
measurement, and position the antenna as high as possible.

There are two ways to mount the antenna; magnetic mount or pole 
mount.

Magnetic Mount

The magnetic mount can be screwed into the bottom of the antenna and 
mounts to metal surfaces. A metal disc and foam adhesive are included 
with each magnetic mount. Use the foam adhesive to bond the metal 
disc to the desired mounting location if there are no metal surfaces. To 
use the metal disc and foam adhesive:

1. Clean and dry the mounting surface on the vehicle or vessel.

2. Remove the backing from one side of the foam adhesive and press 
the metal plate onto the mounting surface on the vehicle.

3. Remove the backing from the other side of the foam adhesive.

4. Press the metal plate onto the mounting surface on the vehicle.

5. Apply firm pressure to ensure good adhesion.

6. Place the antenna on top of the metal disc.
9
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Pole Mount

The center thread of the antenna is 5/8 inches for compatibility with a 
survey pole (not included). Simply thread the pole into the antenna.
10



R220 User Guide

875-0212-000 Rev. A1 ECLIPSE.R200.book  Page 11  Thursday, October 16, 2008  1:18 PM
Connecting the Cables

The power cable must reach an appropriate power source. The data 
cable may connect to a data storage device, computer or other device 
that accepts GPS data. The antenna cable must reach from the antenna 
to the R220 receiver.

When choosing a route for all of the R220 cables:

• Avoid running cables in areas of excessive heat

• Keep cables away from corrosive chemicals

• Do not run the extension cable through door or window jams

• Keep the cables away from rotating machinery

• Do not bend excessively or crimp the cables

• Avoid placing tension on the cables

• Remove unwanted slack from the extension cable at the 
receiver end

• Secure along the cable route using plastic wraps

Warning!

Improperly installed cables near machinery can be dangerous.
11
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Connecting the R220 to External Devices

The R220 has two serial ports. It also shares Port A with a USB 
connection. If a valid USB connection is made, messages can be logged 
to both the serial port A and the USB port. Commands can be sent via 
the USB if connected or to the serial port if there is no USB connection.. 
The USB port is designed to be connected to a host device such as a PC. 
The PC should recognize the R220 as a serial device. A new COM will 
appear as a valid connection on the PC. Set the communication 
software to use this new port to access the R220.

The serial ports of the R220 operate at the RS-232C interface level to 
communicate with external data loggers, navigation systems and other 
devices. The two serial ports are accessible via the back panel. On the 
R220 the serial ports are accessible via two DB9 female connectors. 
Either serial port can also be used for firmware updates. Figure 2-1 
displays the numbering for the DB9 connector (female). The associated 
numbering for the plug connector (male) is a mirror reflection of the 
scheme shown in Figure 2-1.

Figure 2-1. DB9 socket numbering
12
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Note: The baud rate for both the R220 serial port and the device 
to which they are connected must match for successful 
communication. Table 2-1 on page 13 and Table 2-2 on page 13 
provide the pin configuration for the serial ports.

Table 2-1:  Port A pin-out, DB9 connector pin number description

Pin Function

1 Not connected

2 Transmit data Port A

3 Receive data Port A

4 Not connected

5 Signal ground

6 Not connected

7 Not connected

8 Not connected

9 5V output, 350 mA MAX

Table 2-2:  Port B pin-out, DB9 connector pin number description

Pin Function

1 Not connected

2 Transmit data Port B
13
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Serial and USB Ports

The R220 features two serial ports and two USB ports. The ports handle 
communication to and from the R220. The ports may be configured for 
a combination of NMEA 0183, binary data and/or RTCM SC-104 data.

The USB configuration of the R220 receiver comprises two USB-A male 
connectors. Each port has its function marked on the end plate of the 
receiver. 

The port marked “Data Com” is for data communication to the receiver. 
There is a USB-A to USB-A cable included with your receiver to use with 
this port. Connect one end of the supplied cable to the receiver and the 
other end to a host computer. The computer should immediately 
identify the receiver as a generic serial port and load the appropriate 
driver. If no appropriate device driver is found, you can download the 
driver from:

http://www.ftdichip.com/Drivers/VCP.htm

3 Receive data Port B

4 Not connected

5 Signal ground

6 Event marker

7 Not connected

8 Not connected

9 1 PPS

Table 2-2:  Port B pin-out, DB9 connector pin number description

Pin Function
14
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When connecting the R220 USB “Data Com” port to your computer, you 
will need to install the FTDI drivers, twice. Once the correct drivers are 
installed, a pop-up will appear in the lower right corner of your 
computer screen. The pop-up will state that new hardware has been 
installed on your computer. The hardware is installed as a “Microsoft 
Serial BallPoint”. In order for your computer to recognize the USB “Data 
Com” port, you need to disable the “Microsoft Serial BallPoint”.

Step 1: Go into Control Panel and click Systems.

Step 2: In the Systems window, click on the Hardware Tab and then 
click on Device Manager.

Step 3: In the Device Manager, select Mice and other pointing 
devices from the tree fields and right-click on Microsoft Serial 
BallPoint and select disable.

This USB DATA port automatically switches the PORT-A receive line 
from the DB9 connector to the USB connector when the USB cable is 
connected and the Microsoft Serial BallPoint has been disabled. You 
may still receive data on both USB and PORT-A at the same time and the 
same baud rate, but only talk to the receiver on the USB port when it is 
connected. When the USB cable is unplugged, PORT-A will return to 
normal use.

The second port marked “MEM STICK” is used for data logging onto a 
USB memory stick. If there is a status LED on your memory stick, it 
should become active after the receiver has identified the USB memory 
stick inserted into the connector. For further data logging options on the 
memory stick, please see the following section on the data logging 
menu.

Note: Do NOT uninstall the Microsoft Serial BallPoint. 
Uninstalling will only result in reinstallation once the computer 
has been shut down or restarted.
15
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If you mistakenly connect the supplied USB-A to USB-A cable into the 
“MEM STICK” connector or a USB memory stick into the “DATA COM” 
port, the USB functionality will not work. The ports are not 
interchangeable. Only when the appropriate device is connected to the 
appropriate connector will the USB functionality work.
16
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USB Data Logging

Once a USB memory stick has been inserted into the receiver, the data 
logging menu will show the memory stick free space and allow data 
logging to begin. A data menu will confirm that your memory stick is 
logging.

To configure the data stored to the memory stick, enter the “Config” 
submenu of the main Data Logging menu. You can have the receiver 
auto-select a file name for you or enter your own filename. If entering 
your own filename, you may select to append or overwrite an old file of 
the same name. No additional warnings are given to confirm the 
overwriting of an old file. If the receiver is auto-generating the file name 
for logging, it will always generate a name for the file so that no other 
files are overwritten. 

For RAW data logging, you may also want the receiver configuration to 
be inserted into the file. If this option is selected, the file will start with 
the receiver configuration comprised of the replies to the $JI, $JK, $JT, 
and $JSHOW queries. You may also select the data logs to be logged to 
the file and their respective periods. You can select any number of logs 
and any period to meet your needs. Keep in mind that the logged data is 
limited by your receiver subscriptions. You can see your subscription 
state in the “System Setup” menu by going to the “Software Disc” and 
then “Authorizations” sub menu.

You can log data to the USB memory stick in Google Earth KML format 
with latitude, longitude and height, or in a Comma Separated Values 
(CSV) format with the time, latitude, longitude, and height. 

Data files are always stored in the root directory of the memory stick. 
There is no support for logging to sub-directories.
17
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Custom Configuring the R220

All aspects of the R220 may be configured through the serial port with 
the use of Hemisphere GPS commands. Many aspects of the R220 
receiver can be configured. Please refer to Hemisphere GPS’ GPS 

Technical Reference for specific command details.

Note: An authorized code is required to enable the output of the 
binary 76 data message.

Warning! 

Always stop the data log before removing the memory stick 
from the receiver. Failure to do so may result in a loss of data.

Note: If you have any questions, contact your local Hemisphere 
GPS dealer for more information regarding the use of 
Hemisphere GPS commands and customized configuration.
18
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Environmental Considerations

The R220 receiver is designed to be placed indoors. It is, however, 
splash proof in case of accidental exposure. The antenna is designed to 
be used outdoors. See Table B-3 on page 50 of Appendix B, for the 
environmental specifications.

Note: The changes made to the R220 via the serial port will not 
be saved to the memory unless a save command is issued 
($JSAVE). If changes are made via the menu system, they will 
automatically be saved.
19
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Introduction

The R220 was created for easy operation. This chapter provides 
information on the following topics:

• How to start the R220

• The LEDs

• The R220’s Main Menu and Differential Menu
22
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Starting-Up the R220

To start-up the R220:

1. Connect the ends of the R220 power cable to a power source 
providing between 8 and 36 VDC. The power supply should be 
continuous and clean for best performance. Table B-1 on page 40 of 
Appendix B, provides the R220’s power specifications.

2. Turn on the system by pressing the on/off switch on the back panel. 
.

The R220 features reverse polarity protection to prevent damage if 
the power leads are accidentally reversed. With the application of 
power, the R220 will proceed through an internal start-up 
sequence, however, it will be ready to communicate immediately.

The first start-up can take from 5 to 15 minutes depending on the 
location. Subsequent start-ups will output a valid position within 1 
to 5 minutes depending on the location and time since the last 
start-up

Note: Hemisphere GPS suggests that a weather-tight 
connection and connector be used if the connection will be 
located outside.

Warning!

Be careful not to provide a voltage higher than the input range 
(36 VDC). This will damage the receiver and will void the 
warranty.

Do not attempt to operate the R220 with the fuse bypassed. Such 
a modification will void the product warranty
23



3: Operating Basics

875-0212-000 Rev. A1 ECLIPSE.R200.book  Page 24  Thursday, October 16, 2008  1:18 PM
Note: It can take up to five mintues for the R220 to receive a full 
ionospheric map from SBAS. Once it receives a complete map, 
the R220 will operate at optimum accuracy..
24
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Understanding the LEDs

The R220 has three LEDs:

• Power Indicator LED - red. This LED illuminates 
when the R220 is powered. 
 

• GPS Lock Indicator LED - yellow. This LED 
remains illuminated once the R220 achieves a 
solid GPS lock.

• DGPS Position Indicator LED - green. This LED 
illuminates solid green when the receiver has 
achieved a differential position and a pseudo 
range residual of better than the value 
specified by the $JLIMIT command. (The 
default is 10.0 meters (32.8 feet)). If the residual 
value is less than the current threshold, the 
green LED will blink indicating that differential 
mode has been attained, but the residual 
threshold has not been met.
25
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Navigating the Menus

The R220 menu system is designed for easy setup and configuration of 
the unit in or out of the field. Most configurations can be done entirely 
through the menu system without having to connect to a computer or 
PDA. The menu software supports many different languages so that the 
configuration of the receiver can easily be understood. 

Main Menu

There are five sub-menus available on the main menu screen of the 
R220:

• GPS

• Differential Corrections

• Configuration Wizard

• System Setup

• Data Logging

Menu maps for each sub-menu are included in this section for easy 

navigation. 

Note:To return to the factory default configuration: 

Hold down the ENTER key on start-up until the splash screen 
disappears. 
26
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GPS Menu

The GPS menu allows you to view and edit your GPS settings. Settings 
include the data port outputs, specific positioning parameters, UTC time 
offset, and satellite visibility and positioning information.
27
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Differential Corrections Menus

The Differential Corrections menu allows you to view your differential 
settings. The name of the differential menu shown in the display reflects 
your current differential source. So, for example, if you are using SBAS, 
you will see “SBAS” and the associated menu options.

Differential sources available on your unit will vary depending on the 
model and differential correction subscriptions you may have 
purchased. Potential options include:

• SBAS

• Autonomous

• Base Station

• L-Dif

• External RTCM

From these menus, you can view your current status or adjust settings.
28
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SBAS Menu  - 

Autonomous Menu - 

GPS >
Autonomous >
Config Wizard >
System Setup >
Data Logging >

No Diff Source
Diff > Autonomous
Back >
Top Menu >
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Base Station Menu - 

L-Dif Menu - 

GPS >
Base Station >
Config Wizard >
System Setup >
Data Logging >

Reference >
Radio > 
Back >
Top Menu >

MFR:   XXXXXX
Radio ID;    7
Frequency: 
Back >
Top Menu >

Lt: >
Ln: >
Hgt: >
Set Reference: >
Use Current Pos: >
Back >
Top Menu >

GPS >
L-Dif >
Config Wizard >
System Setup >
Data Logging >

DiffPort >
DiffBaud >
Radio > 
Back >
Top Menu >

MFR: XXXXXX
Radio ID: 
Frequency:
SNR:
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                            External RTCM Menu - 

GPS >
External RTCM >
Config Wizard >
System Setup >
Data Logging >

RTCM Port > Port A
RTCM Baud > 19200
Diff > Extern RTCM
Back >
Top Menu >
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Configuration Wizard Menu

The Configuration Wizard walks you through basic settings to get up 
and running.  
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System Setup Menu

The System Setup menu enables you to quickly view and edit current 
system settings. General settings include such items as current 
applications, units, baud rates, logs, LED contrast, subscription code, 
and languages. 

GPS >
SBAS >
Config Wizard >
System Setup >
Data Logging >

Display Apps >
Display Format >
Baud Rates >
Display Logs >
Software Disp >
Contrast >
Animation > Off
Subscription >
Flip Display > No
LCD Off > No
Language >
Back >
Top Menu >

In- Use > WAASRTKB
Other > OMNIHP
Swap Applications >
Back >
Top Menu >

Disp Update > 1Hz
LL Unit > DM.M
Hgt Unit > meters
Vel Unit > km/h
Back >
Top Menu >

PORT A > 9600
PORT B > 9600
Back >
Top Menu >

GGA > No
GLL > 1Hz
GSA > 1Hz
GST >
GSV > 1Hz
…
RD1 > No
RTCMv3>No
ROX > No
Back >
Top Menu >

Menu System >
Crescent App >
S/N >
Back >
Top Menu >
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Data Logging Menu

The Data Logging menu enables you to log or output job data.  

Format >
Port >
Begin >
Back >
Top Menu >

GPS >
SBAS >
Config Wizard >
System Setup >
Data Logging >

Start/Stop Logging >
98% Free – 28.0Hr
Config 0001 >
Output File >
Back >
Top Menu >

Progress Bar >
Format XXX
PORT A - XXXXXX
Back >
Top Menu >

Start >
End >
Auto-Start >
Period >
Erase File >
Back >
Top Menu >
34
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Using RTK/L-Dif

Introduction

RTK and Local Differential (L-Dif) are two differential options for the 
R220 that provide the most precise accuracy. A local base station is 
required for both differential options. Most commonly, the base station 
is comprised of a GPS receiver, GPS antenna, radio transmitter and 
power source (such as available in the Outback BaselineHD). The base 
station is typically set up near the working area, tracks GPS signals and 
broadcasts differential corrections to a radio and rover GPS receiver. 
The rover GPS system processes the corrections and outputs very 
accurate position information.
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Installing the Base Station

To set up the base station:

1. Place the base station at a location with no obstructions between 
the rover radio and base station. (See to Figure 4-1 and 4-2 on 
pages 37 and 38.)

Figure 4-1. Base station on tripod

Note: Do not place the base station near metal objects.

Make sure the base station is at least 50 meters (160 feet) from 
obstructions.. (See Figure 4-2 on page 38.)
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Figure 4-2. Location of base station

Installing the Rover Radio

Note: Make sure the rover radio and the GPS antenna are at 
least 1 meter (3 feet) from each other.

The GPS antenna must not be blocked by the rover radio.

The rover radio must receive regular corrections 
from the base station, every one to two seconds (differential 
age), for up to 15 minutes to achieve RTK lock (maximum 
accuracy). Typically, a lock is achieved in under five minutes.

5 m 
(16.4 ft)

50 m (160 ft)
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Using the R220 as a Base Station or Rover

The R220 can be used as a base station or rover receiver, but requires a 
subscription. Running a base and rover together requires a link between 
the two in order to transfer the differential corrections. The link can be 
wired or wireless (i.e. radio modem). The corrections must be 
transferred to the rover receiver through the desired link.

To set up the proper application:

1. Make sure the current R220 application is set to WAASRTKB for a 
base station, or RTK for a rover, by using the interface on the front 
panel.

2. Scroll down to System Setup>.

3. Press the ENTER button to enter 
the System Setup menu.

4. Select Display Apps> and press 
the ENTER button to enter the 
Display Applications screen.

Make sure that In Use: displays 
either WAASRTKB for a RTK or L-
Dif base station or RTK for a RTK 
or L-Dif rover receiver. If the RTK 
application only appears as 
Other:, scroll down and select 
SWAP APPLICATIONS. The 
desired application will be shown 
as In Use.
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Note: To obtain RTK readings you must have RTK Rover and RTK Base 
set on your R220.

Connecting the R220 to a PC - This application selection can also 
be done by using a terminal program, such as HyperTerminal®, SLXMon 
or PocketMaxTM. 

When using direct commands from a PC, send the  $JAPP command to 
view the current application. $>JAPP,WAASRTKB,RTK,1,2 should 
appear. This indicates that the WAASRTKB application is active and RTK 
is the secondary application. 

If the response is different and RTK is first, such as 
$>JAPP,RTK,WAASRTKB,2,1, then a $JAPP,other should be sent, this will 
swap applications so that the WAAS RTKB application is used.

1. Make sure the communication cable (part number 051-0160) is 
connected to either PORT-A or the USB DATA COM port of the R220 
receiver.

2. With WAASRTKB or RTK as the active application, the R220 
automatically configures messages on Port B of the receiver for 
correct RTK operation. The baud rate of Port B will also be 
automatically set to 9600.

Connecting the R220 to a Base Station or Rover Via Cable - The 
steps in the preceding section allows the R220 receiver to be used as a 
base station or rover either with or without a radio connection.

To use a wired connection:

1. Connect the R220 to the base station, or rover, with a 9-pin serial 
cable from Port B of the base station to Port B of the rover receiver 
using a null modem adaptor.
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Connecting the R220 Via a Wireless Connection - The R220 can 
be connected through a wireless connection. The wireless connection 
must meet these requirements:

• Non-interference with GPS

• Serial connection set to 9600,N,8,

 

 1

Figure 4-3. BaselineHD rover radio cable

Note: Hemisphere GPS recommend testing with a wired 
condition prior to using a third party wireless connection.

Note: Make sure both the rover radio and base station are on 
the same channel or frequency in order for the rover radio to 
receive corrections from the base station.
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Operation

The R220’s status LEDs indicate the following:

• Yellow: tracking GPS.

• Flashing green: differential has been attained, but the residual 
has not met the threshold.

• Solid green: RTK lock.

The R220 will output standard NMEA messages through Port A. Set the 
message and port output as required by the user-supplied interface.
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Using OmniSTAR

OmniSTAR is a worldwide terrestrial DGPS service that provides 
correction data to subscribers of the system with the use of a 
geostationary transponder. With this service, the positioning accuracy 
does not degrade as a function of distance to a base station, as the data 
content is not composed of a single base station’s information, but an 
entire network’s information. 

The information broadcast by this service is based upon a network of 
reference stations placed at geographically strategic locations. The 
network stations communicate GPS correction data to control centers 
where it is decoded, checked, and repackaged into a proprietary format 
for transmission to a geostationary L-band communications satellite. 
The satellite rebroadcasts the correction information back to earth over 
a large signal footprint where the R220’s L-band differential satellite 
receiver demodulates the data. The resulting corrections are those that 
would be calculated if a reference station were set up at the present 
location. This type of solution ensures a consistent level of accuracy 
across the entire coverage area. 

OmniSTAR Reception

The OmniSTAR service broadcasts at a similar frequency to GPS, and as 
a result, is a line-of-sight system. There must be a line of sight between 
the antenna and the OmniSTAR satellite for reception of the service. The 
OmniSTAR service uses geostationary satellites for communication. The 
elevation angle to these satellites is dependent upon latitude. For 
latitudes higher than approximately 55° north or south, the OmniSTAR 
signal may be blocked more easily by obstructions such as trees, 
buildings, terrain, or other objects.
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OmniSTAR Service Activation

The OmniSTAR service may be activated by contacting the service 
provider in the your region. Contact OmniSTAR with the unit number 
and they will activate the subscription over the air. Please have the 
receiver ready to receive the OmniSTAR signal for subscription 
validation.

For questions regarding the OmniSTAR service, please contact 
OmniSTAR for further information. 

Contacting OmniSTAR

Table 5-1 provides the contact numbers for the various OmniSTAR 
offices throughout the world. 

Table 5-1:  OmniSTAR Contact Information

Location Telephone Number  Fax Number

North America / South 
America

 +1-888-883-8476

+ 1-713-785-5850

 +1-713-780-9408

Europe / North Africa / 
Middle East / West Asia

+1-31-70-317-0900 +31-71-581-4719

Australia / Far East +61-8-9322-5295 +61-8-9322-4164

Southern Africa +1-27-21-552-0535 +1-713-780-9408
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Troubleshooting

Table A-1 provides a checklist to troubleshoot common issues and their 
solutions for the R220.

Table A-1:  Troubleshooting

Issues Possible solution

Receiver fails to 
power

• Verify polarity of power leads

• Check integrity of power cable 
connections

• Check power input voltage  
(8 - 36 VDC)

• Check current restrictions imposed by 
power source (maximum is  
575 mA @ 12 VDC)

• Press the POWER button

No data from 
R220

• Check receiver power status  
(red LED)

• Check integrity and connectivity of 
power and data cable connections

• The volume of data requested to be 
output by the R220 could be higher 
than what the current baud rate 
supports. Try using 19,200 or higher as 
the baud rate for all devices. 

No GPS lock • Check integrity of cable connections

• Verify antenna’s clear view of the sky
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No SBAS lock • Check integrity of cable connections

• Verify antenna’s clear view of the sky

• Check SBAS visibility map

No OmniSTAR 
lock

• Subscription activated and not expired

• Check antenna connections

• Verify antenna’s clear view of the sky

Table A-1:  Troubleshooting

Issues Possible solution
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Table B-5:  Communication specifications

Item Description

Serial ports 2 full duplex RS232, 2 USB

Pulse output 1 PPS (HCMOS, active high, rising 
edge sync)

Baud rates 4800 - 115200

Differential correction  
I/O protocol

RTCM SC-104, Hemisphere GPS 
proprietary

Data I/O protocol NMEA 0183 and Hemisphere GPS 
binary and RTCM

Event mark output HCMOS, active low, falling edge sync, 
10 k-ohm
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